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INTRODUCTION
■ About This Manual
This manual describes the use of business card scanning application CardMinder .

1) About CardMinder
(A quick look at CardMinder)

2) Configuring Before Scanning
(Setting options before scanning)

3) Scanning and Exporting Business Card Data
(Basic procedures for common scanning tasks)

4) Business Card Data Handling
(Maintaining and using your Business Card database)

5) Correcting Recognized Character data
(Correcting the recognized data on a Business card)

6)  Setting Preferences
(Setting CardMinder preferences)

7) Troubleshooting
(Detecting and fixing CardMinder errors)

8)  Index

■ Note, Liability
READ ALL OF THIS MANUAL AND RELATED MANUAL CAREFULLY BEFORE 
USING THIS PRODUCT.
IF NOT USED CORRECTLY, UNEXPECTED INJURY MAY BE CAUSED TO USERS 
OR BYSTANDERS.
While all efforts have been made to ensure the accuracy of all information in this manual, 
PFU LIMITED assumes no liability to any party for any damage caused by errors or 
omissions or by statements of any kind in this manual, its updates or supplements, whether 
such errors are omissions or statements resulting from negligence, accidents, or any other 
cause. PFU LIMITED further assumes no liability arising from the application or use of any 
product or system described herein; nor any liability for incidental or consequential damages 
arising from the use of this manual. PFU LIMITED disclaims all warranties regarding the 
information contained herein, whether expressed, implied, or statutory.
PFU LIMITED reserves the right to make changes to any products herein, to improve 
reliability, function, or design, without further notice and without obligation.
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Use in High-safety Applications

This product has been designed and manufactured on the assumption that it will be used in 
office, personal, domestic, regular industrial, and general-purpose applications. It has not 
been designed and manufactured for use in applications (simply called "high-safety 
applications" from here on) that directly involve serious danger to life and health when an 
extremely high degree of safety is required, for example, in the control of nuclear reactions 
at nuclear power facilities, automatic flight control of aircraft, air traffic control, operation 
control in mass-transport systems, medical equipment for sustaining life, and missile firing 
control in weapons systems, and when provisionally the safety in question is not ensured. 
The user should use this product without adopting measures for ensuring safety in such high-
safety applications. PFU LIMITED assumes no liability whatsoever for damages arising 
from use of this product by the user in high-safety applications, and for any claims or 
compensation for damages by the user or a third party.

■ Trademarks
PFU is a registered trademark of PFU Limited.
ScanSnap and CardMinder are trademarks of PFU LIMITED.
Microsoft and Windows are either registered trademarks or trademarks of Microsoft 
Corporation of the United States and/or other countries.
Adobe and the Adobe logo as well as Acrobat and the Acrobat Logo are either registered 
trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other 
countries.
Other product names referred to in this manual are registered trademarks or trademarks of 
respective companies.
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How Trademarks Are Indicated In This Manual

Color image scanner ScanSnapTM is abbreviated as ScanSnap.
CardMinderTM application is abbreviated as CardMinder.
References to operating systems (OS) are indicated as follows:
Windows 98: Refers to Microsoft® Windows® 98 operating system.
Windows Me: Refers to Refers to Microsoft® Windows® Millennium Edition operating 

system.
Windows 2000: Refers to Microsoft® Windows® 2000 Professional operating
Windows XP: Refers to Microsoft® Windows® XP Professional operating system, and 

Microsoft® Windows® XP Home Edition operating system.
Where there is no distinction between the different versions of the above operating systems, 
the general term "Windows" is used.

All Rights Reserved, Copyright(c) PFU LIMITED 2004.

Multilingual OCR by I.R.I.S.(Image Recognition Integrated Systems) 1997 Copyright by 
I.R.I.S., All rights reserved

The Proximity / Merriam Webster Linguibase
Copyright 1984 All rights reserved
Proximity Technology Inc.
Copyright 1984 All rights reserved
Merriam Webster Inc.

The Proximity / Merriam Webster Linguibase
Copyright 1984 All rights reserved
Proximity Technology Inc.
Copyright 1984 All rights reserved
Williams Collins Sons & Co. Ltd.

No part of this manual may be reproduced in any form without permission.

• The contents of this manual may be revised without prior notice.
• We are unaccountable for any damages or passive damages from the use of this 

equipment or this manual and any compensation of third party.
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Chapter1
1
About CardMinder

This chapter describes the features and basic operations of CardMinderTM.
1.1 About CardMinder................................................................................................... 2

1.2 Features of CardMinder.......................................................................................... 4

1.3 Operation Flow........................................................................................................ 5

1.4 Measurement Windows .......................................................................................... 7
Main window.......................................................................................................... 7
Finder window........................................................................................................ 9
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1.1 About CardMinder

CardMinder is a business card scanning application for image scanners. CardMinder provides a 
quick scanning, image recognition and database storage solution for all your office scanning needs.
Using an OCR (Optical Character Recognition) engine and sharing recognized data with a PIM
(Personal Information Manager), CardMinder is able to...
• Scan business card(s) and save the image data,
• Recognize the characters on the business card and send the character data to a PIM (Personal 

Information Manager),
• Copy scanned business card data and viewer application to removable media for utilizing the 

data on other PCs,
• Link other related files to the business card data,
• Easily find data on a business card using simple keyword searches.

Recognized data

Image data

PIM window (Microsoft® Outlook® for example):

Recognized characters

CardMinder window:
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■ System Requirement

CardMinder runs on the system of the following environment:

Computer
• Intel® Pentium® II 450MHz or higher (Intel® Pentium® III 1GHz or higher is recom-

mended)
• CD-ROM drive (required for the installation of CardMinder)
• ScanSnap* and scanners that complies to TWAIN standard
• Removable media (required for using Mobile linkage function)
• Keyboard
• Mouse
*"ScanSnap" is a FUJITSU´s compact color scanner . Although it is not compatible with 
TWAIN standard, this novel scanner can create PDF files directly from scanned images 
with the touch of a button. 
For more details, refer to the following website . -> http://scansnap.fujitsu.com/

Operating system
Either of the following OS is required:

• Windows 98 (*)
• Windows Me
• Windows 2000 (Service Pack 1 or later)
• Windows XP

(*): When you use CardMinder on Windows 98, Microsoft® Internet Explorer 5.0 or later
is required.

Memory
• 64M bytes or more (128M bytes or more is recommended)

Disk space
• 120M bytes or more
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1.2 Features of CardMinder

CardMinder has the following features:
• Scans front side or both sides of the business cards just by pressing a button on the scanner
• You can capture Memos on business cards to be reviewed later
• Recognizes characters on business cards and creates keywords automatically for fields like Full 

Name or Company.
Keywords: Full Name

Company
Department
Job title
ZIP / Postal codes
Address
Phone number
Fax number
Mobile phone
E-mail
Web site address
Memo
Save date

• Exports recognized data to PIMs (Personal Information Manager) 
Supported Applications: Microsoft® Outlook®

Microsoft® Outlook Express
ACT!TM

GoldMine®
CSV (Excel)

• Searches business cards quickly by Full Name or Company
CardMinder  User’s Guide 4
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1.3 Operation Flow

You can start using CardMinder by:

Selecting
• An application where the data is exported to (See Chapter 2).

Scanning and recognizing a business card (See Chapter 3)

1. Set the business card(s) onto the scanner.
2. Perform a scanning operation.
3. Scanning is completed, and the recognized 

data is displayed on the Main window.

Exporting the data (See Chapter 3)

1. Select the data in the [Inbox] tab.
2. Click the Export icon.

Maintaining the data (See Chapter 4)

1. Select the data in the [Inbox] or [Exported]
tab.

2. Click menu to:
•Search (See Section 4.1)
•Delete from [Inbox] or [Exported] tabs 

(See Section 4.2)
•Delete from [Trash] tab (See Section 4.4)
•Restore (See Section 4.3)
•Attach related files to business card data (See 

Section 4.7)

1

2

1

2

Common
Daily
Tasks
CardMinder  User’s Guide 5
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Extracting the data (See Section 4.5)

1. Select data from the [Inbox] or [Exported] tab.
2. Drag and drop the image data to be extracted.

Viewing the data on other PCs (See Section 4.5)

1. Select data from the [Inbox] or [Exported] tab.
2. Drag and drop the image data onto the  

[Mobile] tab.
3. Set a removable media onto your PC.
4. Click the [Mobile] button. 1

2

CardMinder  User’s Guide 6



1.4 Measurement Windows

A
bout C

ardM
inder

1

1.4 Measurement Windows

There are two measurement windows in CardMinder.

■ Main window

Status bar
Help for menus or buttons.

Command Toolbar
Shows icons for often-used commands.

Mode tabs
Displays data in 
each mode.

Recognition Result / Correction View
Displays recognized data, and is used 
for the data correction.

Image View
Displays the image of 
business card selected 
from the Data List View.

Data List View
Lists the business card data

Image Toolbar
Shows the buttons used to adjust the 
image display in Image View.

Attachment View
Displays the files attached to the 
business card data.
CardMinder  User’s Guide 7
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Icon / Display Function

Command 
toolbar

Starts Scanning of business card(s) from the scanner.
With the [ ] button, you can change scanning settings (Duplex/
Simplex ) and : 
• For ScanSnap: You can set scanning quality (Normal/Better/Best). 
• For TWAIN scanners: You can set resolution (150/200/300/400dpi) 

Activates the recognition of the business card selected in the Data 
List View. Only the characters on the front side of the business card 
are recognized. The recognition result will be automatically displayed 
in Recognition / Correction View.

Copies the business card data in the [Mobile] tab to removable 
medias so that you can utilize the data on other PCs.

Exports the business card data to an application. The data is moved 
from the [Inbox] tab to the [Exported] tab. The icon at the left shows 
Microsoft Outlook. Refer to Section 2 to specify other applications.

Image 
toolbar

The height of the image is adjusted to fit the height of the image 
display view.

The width of the image is adjusted to fit the width of the image display 
view.

The height or width of the image is adjusted to fit the height or width of 
the image display view.

The image size is enlarged.

The image size is reduced.

Rotates the image 90 degrees clockwise. Clicking the [ ] allows the 
setting of the rotation angle.

Displays the front side image.

Displays the back side image. If a back side image does not exist, [No 
Image] is shown.

Displays the front and back side images together. The display method 
of front and back images can be adjusted by clicking on the [View] 
menu, [Show duplex image] menu and it’s submenus. On the left side 
(or Upper side) of the Image View, the front side of the business card 
is shown. On the right side (or Lower side) of the Image View, the 
back side of the business card is shown. If a back side image does 
not exit, [No Image] is shown. 

Swaps the front and back side of the image. The same result is 
obtained by clicking the [View] menu and [Swap data (front and back)] 
submenu.

Displays or hides the Attachment View.
CardMinder  User’s Guide 8



1.4 Measurement Windows

A
bout C

ardM
inder

1

■ Finder window

This window appears when a data search is activated from an application.

Mode tabs

[Inbox] tab
Data that has been scanned but not been exported to an application 
displayed in this tab. 

[Exported] tab Data that has been exported to an application displayed in this tab.

[Trash] tab Data that has been sent to the Trash is displayed here.

[Mobile] tab Displays data to be copied to removable media.

Icon / Display Function

Data List View
Lists the searched business card 
data. This view is not shown when 
only one item is existing.

Image View
Displays the image of 
the business card 
selected in the Data List 
View.

Image Toolbar
Shows buttons to adjust the image display of the Image View.

Attachment View
Displays files attached to the  business 
card selected in the Data List View.
CardMinder  User’s Guide 9
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Icon / Display Function

Image 
toolbar

Displays or hides the Data List View.

Moves an image of a business card when the image is dragged.

The Image size is enlarged so that the clicked point becomes the cen-
ter of the expansion.

Image size is reduced so that the clicked point becomes the center of 
down scaling.

Displays the front side image

Displays the back side image. If a back side image does not exist, this 
icon is disabled.

Previous business card is shown. 

Next business card is shown.

Displays the first business card data

Displays the last business card data

The current business card image and the data are shown on the main 
window.

Displays or hides the Attachment View.
CardMinder  User’s Guide 10



Chapter2
2

Configuration Before Scanning

This chapter describes the settings required to use CardMinderTM and how to change the PIM
application selection.

1. Click the [Start] button on the desktop. Click [Program], [CardMinder V2.0] and [Card-
Minder V2.0] again from the submenus. 

⇒ The main window of CardMinder appears.

2. Click [File] on the menu bar and click [Export to] in the submenu.
⇒ A list of PIM applications appears. A check mark next to an item indicates the currently 

selected application.

3. Click an application to which you want to export the business card data.

HINT

• You can choose only one application. When you change the application, a 
new icon appears in Main window of CardMinder. 

• When you choose CSV (Excel) from the list, also specify the file name and file 
folder. (See HINT:page 22)
CardMinder  User’s Guide 11
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Chapter3
3

Scanning and Exporting Business Card 
Data

This chapter describes the procedure for scanning business cards using a scanner, and sending the
recognized data from the scanned business cards to an associated application.
CardMinder  User’s Guide 12
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3.1 How to Scan Business Cards

This section describes the business cards scanning using the following types of scanners:

•Flatbed 

•ADF (Automatic Document Feeder) (page 17) 

■ Scanning with the Flatbed

1. Open the scanner document cover.

2. Load the business card  facing down on the document bed .  

1. Scanning one card at a time 2. Scanning multiple cards at a time

Arrange the cards so that they do not 
stack on top of and do not stick to one 
another.

Document cover

Document bed

Rear side

Rear sideRear side

Rear sideRear side

Rear sideRear side

Rear sideRear side
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3. If you are scanning multiple cards at a time, spread out a dark-colored paper, and
place it over the business cards.

Use a dark-colored paper that covers the entire glass surface of the document bed.

4. Close the scanner document cover.

5. Select [Scan settings] from the [File] menu.

⇒ The following window appears.

ATTENTION

You cannot scan multiple cards at  a time if 
the types of business cards are the 
following:
• Business cards with a dark-colored line 

running across the length
• Business cards with a dark-colored edge
Scan these business cards one at a time.
When you place the business cards one at a time, it is necessary to specify 
"1 card to reference point" on "Flatbed scanning method" of the 
[Scan settings] dialog box. Refer to "CardMinder Help" for details on the 
[Scan settings] dialog box.

ABCD LIMITED

Haward Brown
Project Manager.  Software Research

226 Airport Parkway, Suite 030
San JOSE, CA 95110

Phone: (408) 453-0000
Fax: (408) 453-0001
haward@abcd.com
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6. For TWAIN scanners, click the [Select Scanner] button.

For Scansnap, this step is not required. Go to step 8.

7. Select the scanner to be used, and click the [Select] button.

8. At "Scanner type", select "Flatbed".

9. At "Flatbed scanning method", specify the "Loading mode" of the business card(s).

1). To scan one card at a time, select "1 card to reference point".
2). To scan multiple cards at a time, select "Multiple cards".

HINT

If you select the check box for "Show TWAIN driver dialog box when scanning 
starts", the driver dialog box will appear before scanning starts and you will be 
able to specify scanning settings.
CardMinder User’s Guide 15
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10. At "Capturing Side / Color Mode / Resolution", specify the scanning settings.

11. When the configuration is finished, click the [OK] button to close the [Scan settings]
window.

12. Click the [Scan] button on the toolbar.

⇒ When the scanning has been completed, the image of the [Inbox] tab is displayed on the 
main screen.

Capturing Side If the business card is printed on one side, select "Simplex". If it 
is printed on both sides, select "Duplex". For "Duplex", after the 
front side is scanned, the rear side will be scanned. 
When the message below appears, turn over the business card, 
and click the [OK] button.

If you click the [Cancel] button, it becomes simplex scanning 
mode.

Color Mode Specify the color mode between "B&W" (Black & White) and 
"Color".

Resolution Specify the resolution to be used.
For ScanSnap: "Normal", "Better" and "Best". 
For TWAIN scanners: 150, 200, 300, and 400dpi .
To scan in color: "Better" or 300dpi is recommended.
To scan in B&W: "Best" or 400dpi is recommended.
CardMinder User’s Guide 16
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■ Scanning with the ADF (Automatic Document Feeder)

1. Load a business card onto the scanner.

(To scan multiple cards, stack the cards together and load them.)

2. Select [Scan settings] from the [File] menu.

⇒ The following window appears.
CardMinder User’s Guide 17
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3. For TWAIN scanners, click the [Select Scanner] button.

For Scansnap, this step is not required. Go to step 5.   

4. Select the scanner to be used, and click the [Select] button.

5. At "Scanner type", select the scanner type to be used from "ADF Simplex/ADF
Duplex".

HINT

If you select the check box for "Show TWAIN driver dialog box when scanning 
starts", the driver dialog box will appear before scanning starts and you will be 
able to specify the scanning settings.

ATTENTION
When scanning multiple business cards printed on both sides with 
ADF simplex-type scanners, the front sides of all the cards are scanned first, 
then you will be asked to turn over the cards, and the rear sides are scanned 
next. The front and the rear sides data will be linked together for each card. 
However the scanned sheet order may change depending on the mechanism 
of your scanner. 
In order to match the linkage of the front and rear sides correctly, be careful 
when selecting the scanner type: 
• Type: The sheet order is reversed when the sheets are ejected

Front side: scans from the front side of the first sheet.
Rear side: scans from the rear side of the first sheet.

• Type: The sheet order remains the same when the sheets are ejected
Front side: scans from the front side of the first sheet. 
Rear side: scans from the rear side of the last sheet.
CardMinder User’s Guide 18
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6. At "Capturing Side / Color Mode / Resolution", specify the scanning settings.

7. When the configuration is finished, click the [OK] button to close the [Scan settings]
window.

8. Click the [Scan] button on the toolbar.

⇒ When the scanning has been completed, the image of the [Inbox] tab is displayed on the 
main screen.

Capturing Side If the business card is printed on one side, select "Simplex". If it 
is printed on both sides, select "Duplex". If the scanner is "ADF 
Simplex", and "Duplex" is selected, after the front side is totally 
scanned, the rear side will be scanned. 
When the message below appears, turn over the business card, 
and click the [OK] button.

If you click the [Cancel] button, it becomes simplex scanning 
mode.

Color Mode Specify the color mode from among "B&W" (Black & White) and 
"Color".

Resolution Specify the resolution to be used.
For ScanSnap: "Normal", "Better" and "Best". 
For TWAIN scanners: 150, 200, 300, and 400dpi .
To scan in color: "Better" or 300dpi is recommended
To scan in B&W: "Best" or 400dpi is recommended.

HINT For ScanSnap fi-5110EOX, you can also press the [SCAN] button  to 
scan.

For the ScanSnap fi-4110EOX series, you can also press the  (duplex 

scan button) or  (simplex scan button) to scan.

In this case, scanning is done by following the settings of "  ScanSnap 
Manager (or ScanSnap Monitor) - Scan and Save Settings" dialog box.

SCAN

Simplex

SS
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3.2 Exporting to Associated Application

1. When scanning is completed, the Main window [Inbox] appears. Click a business card
in the Data list and verify the recognized result of the front side image.

 You can correct the recognized data here (See Chapter 5.5). 

2. Select the data you wish to export.
You can add data to the selection by clicking on the item to be added while pressing the 
[Shift] or [Ctrl] key.

HINT

• This example shows both image sides. (See Section 1.4) The display mode 
can be adjusted by clicking [View] in menu bar and  [Show two sided image] 
from the submenu.

• If you check the column "Register Card Information automatically" in the pref-
erence setting window, you can immediately save the data without confirming 
the recognized result. (See Section 6.1) <Only for ScanSnap>

• This setting is not recommended because a wrong name or company may be 
registered in your database without your confirmation.

Data list Recognized data

Front side Backside
CardMinder User’s Guide 20
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3. The following steps show an example using Microsoft Outlook. Click the [Microsoft
Outlook] icon on the toolbar.

⇒ The data selected in Step 2 is exported to Microsoft Outlook. The data is then erased 
from the [Inbox] and added to [Exported].
You can confirm the export by activating Microsoft Outlook, and opening the [Contacts] 
folder as follows.

HINT

• Export can also be activated by clicking [File] in menu bar and [Export] in the 
submenu.

• The items which are displayed in the Recognized data area (except [Memo] 
and [Save date]) are exported to the application.
Refer to "6.2 Export item settings" (page. 51) for setting the exported item. 
CardMinder User’s Guide 21
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HINT

• For Microsoft® Outlook Express, ACT!TM or GoldMine®, only the Icon changes while 
the procedure for this operation is exactly the same.

• When exporting data to CSV (Excel), click the [CSV (Excel)] icon and specify 
a file name and file folder for Excel to save the data.

The items which are displayed in the Recognized data area (including [Memo] 
and [Save date]) are exported to the application.
Refer to "6.2 Export item settings" (page. 51) for setting the exported item. 
CardMinder User’s Guide 22



Chapter4
4

Business Card Data Handling

This chapter describes how to search, delete, restore and extract data items from a business card.
4.1 Data search by character string and hot key ..................................................... 24

4.2 Deleting the data from the [Inbox] / [Exported] tab ........................................... 25

4.3 Restoring data from the [Trash] tab.................................................................... 26

4.4 Deleting data from the [Trash] tab ...................................................................... 28

4.5 Extracting the image data .................................................................................... 30

4.6 Data search by entering a keyword..................................................................... 31

4.7 Attaching related files to the business card data .............................................. 32

4.8 Viewing the business card data on other PCs ................................................... 35
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4.1 Data search by character string and hot key

With CardMinder, you can search business card data including a character string on other applica-
tion windows.

1. Select a character string of a name or a company in any document (e.g. Notepad).

2. Press the hot key (Alt+F3).
⇒ CardMinder starts searching automatically.
⇒ The Finder window opens if the selected character string matches the CardMinder data-

base.

HINT

• Default setting for the hot key is Alt+F3. If you want to change the hot key, 
refer to Section 6.1.

• Even when the searching failed, the Finder window will be displayed (See set-
ting [Action] in Section 6.1). However, no image will be displayed on the 
Finder window. You can enter a keyword in the [Search Text:] column and 
continue searching.

The number of the card 
data found by searching is 
displayed.
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4.2 Deleting the data from the [Inbox] / [Exported] tab

A method to delete the data from the [Inbox] or [Exported] tab is as follows. The data will be sent 
to [Trash].

1. Open CardMinder and select the [Inbox] or [Exported] tab.

2. Select the data you want to delete.
You can add data to the selection by clicking the data while pressing the [Shift] or [Ctrl] key.

3. Click [Delete] in the [Edit] menu bar.

⇒ The Selected data is sent from the [Inbox] or [Exported] to [Trash]. If you want to restore 
the data from [Trash], see Section 4.3. for further details.

HINT

You can also delete the data by:
• Pressing the [Delete] key on the keyboard,
• Drag&Drop the data to the [Trash] tab,
• Right click the data and select [Delete].

Select the data
 in  this list.
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4.3 Restoring data from the  [Trash] tab

A method to restore the data from the [Trash] tab is as follows. Restored data will be removed to 
[Inbox] or [Exported] to their original location.

1. Open CardMinder and select the [Trash] tab.

⇒ The deleted data is shown on the window.

2. Select the items you wish to restore from the [Trash] tab.
You can add data to the selection by clicking on the data item while pressing [Shift] or [Ctrl] 
key.

3. Click [Edit] on the menu bar and [Undo] from the submenu.

HINT

Data that was once deleted from the [Trash] tab cannot be restored.

Select the 
data
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⇒ The elected data moves from [Trash] to the [Inbox] or [Exported] tab.

HINT

Otherwise, right click the data and select [Restore] from the menu to restore 
the selected data.
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4.4 Deleting data from the [Trash] tab

To permanently delete data from the [Trash] tab, follow the procedure given below. The data is 
permanently deleted and cannot be restored by the procedure described in Section 4.3.

■ Select the data to be deleted

1. Open CardMinder and select the [Trash] tab. 

2. Select the data you wish to delete. You can add data to the selection by clicking on
the data while pressing the [Shift] or [Ctrl] key.

3. Press the [Delete] key, or selct [Delete] on the menu bar under [Edit].

⇒ Selected data in the [Trash] tab is deleted from the CardMinder database.

ATTENTION
• The data will be permanently deleted by this method.
• The attached files are also deleted with the card data.

Select the 
data
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■ Empty [Trash]

1. Start CardMinder and select the [Trash] tab.

2. Select [Empty Trash] from the [File] menu.

⇒ All data in the [Trash] tab will be deleted from the CardMinder database.

ATTENTION
• The data will be permanently deleted by this method.
• The attached files are also deleted with the card data.
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4.5 Extracting the image data

You can extract business card data using CardMinder and convert the data into PDF format to 
attach it to your e-mails as follows.

1. Select the data you wish to extract.

2. Drag a business card image from the CardMinder window to any folder in the Explorer
or to your Desktop.

⇒ An image of the business card will be created where you drop it.

3. You can attach the PDF file(s) (image data) to your e-mail using your mailing soft-
ware.

HINT

If both sides of the card are displayed, only one side can be dragged at a time

Select the 
data
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4.6 Data search by entering a keyword

Yiu can search data by entering a keyword using the proceduire given below.

1. Open CardMinder and select [Find] in menu bar under [Edit].

2. The [Find] dialog box will be displayed. Enter a Name or a Company in the column
[Find what], then click the [Find] button. 

⇒ Searched business card data will be displayed on the Main window. If the searching fails, 
the message [End of Search] appears on the screen.
The [Find] dialog box will be still displayed on the screen for further searchings.

HINT

[Direction] setting
Back: Earlier business card data than the currently displayed data is searched.
Front: Later business card data than the currently displayed data is searched.
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4.7 Attaching related files to the business card data

You can attach files to the business card data using CardMinder.
For example, mark a business card data by attaching photos or profiles.
Follow the procedure below to attach files to the data.

■ Attaching files to the business card data

1. Select the card data you wish to attach files to.

2. Select [Edit] - [Attach files] - [Add] from the menu bar, or right click on Attachment
View and select [Add].

⇒ The [Open] window appears.

HINT When Attachment View is not displayed, click the  icon.

Select the 
data

Attachment View

or
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3. Select a file to attach and click the [Open] button.

⇒ The selected file is displayed on the Attachment View.

HINT
• You can also attach a file by drag&drop the file onto Attachment View.

• 100 attached files can be registered at the maximam.
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■ Opening the attached file

Click the icon of the attached file on Attachment View.

⇒ The application linked to the file starts automatically and the file will be displayed.

■ Deleting the attached file

1. Select the file to be deleted on the Attachment View.

2. Select [Edit] - [Attach files] - [Delete] from the menu bar, or right click on Attachment
View and select [Delete].

⇒ The attached file selected is deleted from the Attachment View.
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4.8 Viewing the business card data on other PCs

You can copy the business card data and their viewer software to aremovable media for viewing or 
searching on other PCs.
Follow the procedure below to make copies on removable media.

■ Select the data to copy

1. Start CardMinder and select the [Inbox] or [Exported] tab.

2. Select the data to copy.
You can add data to the selection by clicking on the data item while pressing [Shift] or [Ctrl] 
key.

3. Drag&drop the data onto the [Mobile] tab.

HINT

• If the data to copy are in the [Inbox] tab and [Exported] tab, copy them to a 
removable media.

• Dropping the data does not move the original data, but copies it to the [Mobile] 
tab.

Select the 
data
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■ Copying the business card data to removable media

1. Start CardMinder and select the [Mobile] tab.

2. Set the removable media to your PC.

3. Select [File] - [Mobile linkage] or click the [Mobile linkage] icon.

⇒ The [Mobile linkage setting] window appears.

4. Configure the settings on the [Mobile linkage setting] window.

HINT

• Removable media are recording media that can be connected to or discon-
nected from the PC as needed. Magneto-optic disks, Flash memory devices 
(for USB interface, etc.) can be used for this function.
(* CD-R/RW, DVD-R/RW cannot be used.)

• Removable media larger than 64MB is recommended.
(At least 8MB of memory is required as the space for the business card data 
and its viewer application.)

• Floppy disks do not have enough space for using this function.

or
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Target data:
Select the data from the [Inbox], [Exported] or [Mobile] tabs depending on where the data is 
stored. All the business card data in the specified tab are copied to the removable media 
specified at the menu below. Select [Mobile] when copying the data of the [Mobile] tab.

Drive:
Select the drive to where the selected data will be copied to. Clicking the [ ] button , and 
choose the available removable media from the list.

Data to transfer:
Specify whether or not to include graphic data of business cards in the data to copy.

Number of data:
Indicates how many business card data are selected.

Data volume:
Indicates the size of currently selected business card data.

[Check disk space]
The selected business card data size is calculated, and it displayed on [Data vol-
ume:].  

Free disk space:
Indicates free space on the removable media on the selected drive.

5. Click the [Transfer] button.
⇒ The copying of the selected business card data will be started.

6. When copying operation is completed, click the [OK] button.

7. Remove the removable media from your PC.

HINT

When Some files exist in the [Mobile] tab, the default setting is "Mobile".
When No file exist in the [Mobile] tab, the default setting is "Entire data".

HINT

• File size becomes larger when graphic data of business card are 
included. When there is not enough space on the removable media, 
unmark this [Include image data] check box.

• The files linked to the business card data will not be copied.
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■ Utilizing the business card data on removable media

1. Connect the removable media to a PC.

2. Select [My Computer] from the [Start] menu.

3. Select the removable media.

4. Double click [BizCardViewer.exe] icon.
⇒ The [CardMinder Viewer] window will be displayed.

Icon / Display Function

Image toolbar

Displays or hides the Data List View.

Displays front side image.

Displays the back side image. If the back side image does not exists, 
[No Image] is shown.

Previous business card is shown. 

Next business card is shown.

Image Toolbar
Shows the buttons used to adjust the image display in the Image View.

Data List View:
Shows the list of searched data. 
This window is not displayed if 
the searching result contains 
only one business card.

Image View
Displays the image of business card 
selected from the Data List View.

Search:
Enter keywords for searching business card data.
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5. Enter keywords in [Search:] to start searching business card data.
⇒ The business cards will be displayed as search results.

■ Deleteing data from removable media

1. Connect the removable media to a PC.

2. Select [My Computer] from the [Start] menu.

3. Select the removable media.

4. Delete the following files and folder.
Files: BizCardViewer.exe, autorun.inf
Folder: [BizCardViewer] folder

Image toolbar

Displays the first business card data

Displays the last business card data

Displays graphic data of the business card. This button is only 
enabled when the graphic data is copied.

Displays the character data of the business card.

HINT

• To display all the business card data, enter " * " in [Search:].

Icon / Display Function
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Chapter5
5

Correction of Recognized Character Data

As the recognition cannot be perfect for all business cards, a revision of the recognized data is
strongly recommended. This chapter describes how to correct the recognition results.
Some notice before data correction:
• If the orientation of the characters in the front side is incorrect, correct the orientation by click-

ing  as shown Section 1.4. Then try again.
• If the front side of the business card is shown on the right side (or lower side) of the Image 

View window, swap the images by clicking   and try the recognizing again (See Section 5.2).
• If  photos or logos are very close to characters, miss-recognition may occur. In this case, 

exclude the image area by using the rectangle selection method (Section 5.3 or 5.4), and try the 
recognition again.

• If the character recognition does not succeed even after performing the above given procedures, 
enter the correct character(s) manually.

ATTENTION
• The items to be recognized can be changed. See Section 6.2.
• Quality of OCR(Optical Character Recognition) depends on:

1. Placement of the text on the business card
2. Font size used for the text.
3. Style of the used font.
4. Condition of the business card.
5. Other factors may also affect the recognition performance.
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5.1 Selection of language

The character recognition function of CardMinder supports English, German, French, Italian, and 
Spanish. 
When selecting a language manually, select it following the procedure below before recognizing
business cards.

1. Select [Tool] - [Recognition Language] or use the [Recognition] icon.

2. Select a language from the following window.

⇒The selected language is marked and the setting is applied to the recognition.

HINT

When selecting "Automatic", CardMinder automatically selects a language 
according to the scanned business cards.

or
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5.2 Recognition of all characters at once

The data in the [Inbox] and [Exported] tabs can be corrected using the same method. Correction of 
the data from the [Inbox] is described below.

1. Select the items you wish to recognize from the [Inbox] tab.

2. Click the [Recognition] icon on the toolbar.

⇒ All characters are recognized. Old recognition data is replaced by the new data.

HINT

Only the front side characters can be recognized.

Select
the data

Recognized
data

Front side Backside
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5.3 Recognition using Rectangle Selection

The data in both the [Inbox] and [Exported] tabs can be corrected using this same method. 

1. Select the items that you wish to recognize from the [Inbox] tab. 

2. Select the area to be recognized on the front side image by using your mouse as
shown below.

HINT

Only the front side characters can be recognized.

Select
the data

Recognized
data

Front side Backside
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3. Click the [Recognition] button on the toolbar.

⇒ All characters are recognized. Old recognition data is replaced with the new data.
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5.4 Keyword Recognition using Rectangle Area 
Selection

This Section describes the recognition of selected keywords using a rectangle area. 
The data in the [Inbox] and [Exported] tabs can be corrected with the same method. 

1. Select the items you want to recognize from the [Inbox] tab. 

2. Specify the trimming area for the recognition of the front side image with your mouse
as shown below. Following is an example for the correction of [Company].

HINT

Only front side characters can be recognized.

Select
the data

Recognized
data

Front side Backside
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3. Click the [Company] button located in the lower area of the Main window.

⇒ The data of the selected column is recognized. Old recognition data is replaced with the 
new data. 

HINT

Columns other than [Company] can be corrected using the method above.
Correctable Item
[Full Name], [Company], [Depertment], [Job title], [ZIP/Postal codes], 
[Address], [Phone number], [Fax number], [Mobile phone], [E-mail], [Web 
site address], [Memo]
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5.5 Data Correction by Manual Entry

The data in the [Inbox] and [Exported] tabs can be corrected using the same method. Data correc-
tion for the [Inbox] tab is described in this example.

1. Select the items you wish to recognize from the [Inbox] tab. 

2. Click on the text you wish to correct.
Following shows an example of the correction of [Full Name].

⇒ A cursor appears in the selected column.

3. Enter the correct name in the filed [Full Name] manually.

HINT

Columns other than [Full Name] can be corrected using a similar method.
Correctable Item
[Full Name], [Company], [Depertment], [Job title], [ZIP/Postal codes], 
[Address], [Phone number], [Fax number], [Mobile phone], [E-mail], [Web 
site address], [Memo]

Select
the data

Recognized
data

Front side Backside
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Setting Preferences

This chapter describes how to set CardMinder preferences.
6.1 Data control settings ............................................................................................ 49

6.2 Export item settings ............................................................................................. 51

6.3 Updating CardMinder ........................................................................................... 52
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6.1 Data control settings

Following preference for the data control can be set in this section.
• Display or not display a confirmation window for the recognition result.
• Hot key setting for searching.
• CardMinder Database file folder path name.

1. In the Main window, click [Tool] on the menu bar and click [Settings...].

⇒ The [Configuration] dialog box will be displayed.

2. Click the [General] tab and specify your preference by referring the following Hints.
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HINT

• Setting [Action when image scan complete]
• Shows the  CardMinder window

Displays the result of the character recognition after scanning business 
cards.

• Export Business Card data automatically 
The recognized data is immediately saved without displaying the recog-
nized result. This method is not recommended because a wrong name or 
company can be accidentally registered in your database.

• Setting [CardMinder Viewer]
• Hot key 

Enter the key name in the column [A] for specifying a hot key to activate 
searching after selecting a keyword displayed in other application soft-
ware.
You can specify key name from [A] to [Z], [0] to [9], [F1] to [F12]. Also, the 
key(s) [Ctrl], [Shift], [Alt] have to appear in the beginning.
These keys can be set:

[Ctrl]+[A], [Shift]+[Alt]+[0], [Ctrl]+[Shift]+[Alt]+[F1]
These keys cannot be set:

[9]+[F12], [Ctrl]+[Shift]
• Action

This box is checked as default. When checked, the Finder window appears 
even if the searching does not succeed. In this case no image is shown on 
the Finder window. However,  you can enter a keyword in [Search Text] to 
continue searching.

• Setting [Database]
• Database file

The database file folder (Full path) of CardMinder can be specified using 
this setting.
When [Browse] is clicked, you can specify the Data save folder in the 
[Browse for Folder] dialog box. 
As a default, CardMinder saves data to the C: drive. This setting may be 
useful when C: drive is nearly full and data saving to another drive is 
required. 
Default setting of the folder is,
In case of Windows XP, Windows 2000

C:\Documents and Settings\<- Log-in User name->\Application 
Data\PFU\CardMinder\ENTRY\ENTRYDB.BID

, where <- Log-in User name-> is defined by your network system. 
In case of Windows 98, Windows Me

C:\Program files\Application Data\PFU\CardMinder\ENTRY\ 
ENTRYDB.BID

<About backup of the database>
Copy the following file and folder for backup.

Files: ENTRYDB.BID
Folder: [ENTRYDB] folder
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6.2 Export item settings

The items selected in this section are displayed and recognized by the Main window of CardMin-
der and exported to other application such as Microsoft Outlook.

1. In the Main window, click [Tool] on the menu bar, then select [Settings...].

⇒ The [Configuration] dialog box appears.

2. Click the [Export Item] tab. Then add check marks for the items you wish to export. 
[Default] button resets the settings to the default state.

HINT

The items [Memo] and [Save date] are displayed in the Main window, but they 
won’t be exported.
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6.3 Updating CardMinder

In an effort to improve the usability and functionality of CardMinder, program updates are carried 
out timely.
CardMinder can automatically detect whether the latest program (Update Pack) is available and 
update the program.

When updating CardMinder, follow the instructions below.

1. On the [Help] menu, select [Online Update].

⇒ A message window to confirm whether or not to update ScanSnap Organizer appears.

2. Click the [Yes] button.

⇒ If the latest Update program is available, a message window to confirm the download and 
installation of the program appears. 

HINT

Update Packs are made available without notice. We recommend that you 
update your program regularly.

ATTENTION
• When updating, it is essential that Internet Explorer is installed in a system 

which can access the Internet.
• When updating, it is essential that Internet Explorer is installed in a system 

which can access the Internet.
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3. Click the [Yes] button.

⇒ The program download starts, and the confirmation window appears when it completes.  

4. Click the [Install] button.

.

⇒ Installation starts, and the “Welcome to InstallShield Wizard for CardMinder” window 
appears.
Follow the instructions on the screen to install.

HINT

In case the latest update is already installed, the message below appears.

Click the [OK] button to close the message.

HINT

When you click the [Information] button, Internet Explorer opens and informa-
tion about the latest update for CardMinder appears.
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Troubleshooting

This chapter describes the troubleshooting.

No Phenomena Please confirm,

1 Scanning does not 
start

⇒ Please confirm following items
When using ScanSnap

• Is ScanSnap Manager installed correctly?
Refer to Getting Started of ScanSnap and install the 
ScanSnap Manager correctly.

• Is the ScanSnap icon on task bar shown as  ?
If so, set ScanSnap Manager by referring to the ScanSnap 
Operator’s Guide, so that the icon of ScanSnap Manager 
changes to  .

• Is the [ScanSnap Manager...] window opened?
Scanning is disabled when the window [ScanSnap 
Manager...] is opened. Please close the window.

• Is the scanner supported by ScanSnap?
CardMinder does not support the scanning by scanners 
other than specified by ScanSnap. 

When using a TWAIN scanner

• Is the scanner driver installed correctly? 
Refer to the scanner manual.

• Does the TWAIN scanner driver window remain on the 
screen? 
Close the TWAIN scanner driver window and then scan.

• Is the scanner TWAIN-compliant?
CardMinder is not compatible with scanners other than 
ScanSnap and TWAIN-compliant scanners.

2 Scanned image of 
the business card 
is not displayed on 
window.

⇒ Was the business card scanned with it’s front side facing up? 
The side the name is printed on (Front side) should be set 
downwards, facing the ADF paper chute.

SS

SS
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3 The image is 
scanned, but Full 
Name or Company 
etc. does not 
appear or 
incorrectly appear 
on the Main 
window.

⇒ Review and confirm the following items.
• Is the image of the characters aligned horizontally? If not, 

correct the direction of the image by pressing  , and 
press  on the toolbar.

• Are the front and back sides of the image switched? 
The name should appear on front. Swap the front and back 
side image by clicking   and pressing  on the 
toolbar. (See Section 1.4 for button functions)
Otherwise, try the recognition again by referring to Chapter 
5.

4 The recognition of 
images is not 
correct.

⇒ Confirm the following
• Do the charactor and image 

touch or approach too much?
Those characters cannot be 
recognized. Please correct 
the data manually (See 
Section 5.5).

• Is the color of the characters 
white and the background 
dark?
Those characters cannot be 
recognized. Please correct 
the data manually (See 
Section 5.5).

• Are several phone numbers 
printed together as shown in 
the example?
These phone numbers cannot 
be recognized. Please correct 
the data manually (See 
Section 5.5).

5 The items you wish 
to recognize do not 
appear on the 
window.

⇒ Click the [Tool] menu and the [Setting..] submenu of the Main 
window. Then click the [Export Item] tab. Add the checkmark 
next to the item you wish to recognize and export. (See Sec-
tion 6.2)

No Phenomena Please confirm,

Sales Division 
Quality Control Seciton
Mnager

Hideaki Imai
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The contents of this manual are subject to change without notice.
PFU LIMITED assumes no liability for incidental or consequential 
damages arising from the use of this Product, and any claims by a 
third party.
Copying of the contents of this manual in whole or in part and 
copying of the scanner application is forbidden under the copyright 
law.
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